


| Service Catalog

e Firewall migrations

Firewall operations - mass upgrades,
backups, change/remove/add
Firewall Healthchecks

Panorama design

Zero Trust Network Access

Network Segmentation
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MFA

SSL Decryption

Inbound SSL Inspection
Remote Access (“Always on”)
Securing Cloud infrastructure
Dual ISP redundancy
Network engineering
Endpoint Security/EDR/MDR



I-Contracts

CMAS

NASPO

SPURR

OMNIA Partners
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-Vendors

e Palo Alto Networks e AWS
e Crowdstrike e Microsoft/Azure
e SentinelOne e Proofpoint
e Okta e Zscaler
e Arista e Gigamon
e Juniper e Rapid7
e HPe/Aruba e Knowbe4
e Netskope
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Agenda

General PKI Overview
Disclaimer

Offline Root CA Buildout
Issuing CA Buildout

SSL Inspection With Palo Alto

o1k whpE
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General PKI| Overview
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What is PKI?

Public Key Infrastructure is a system designed to create, manage, distribute, use, store,
and revoke digital certificates and public-private key pairs

e Purpose: Manages creation, distribution, and revocation of digital certificates and
public-private key pairs

e Role: Enables secure, trusted communication across digital platforms (websites,
emails, networks)

e Applications: Widely used in HTTPS, secure email, enterprise access, and code
signing
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Components of PKI

e Public and Private Keys: Each user or device within a PKI system has a unique
public and private key pair. The public key is openly distributed, while the private
key is kept secure. These keys are mathematically linked and work together for
secure data exchange.

e Digital Certificates: Digital certificates, often issued by trusted Certificate
Authorities (CAs), link a public key to an entity's identity. Certificates provide
information about the certificate owner, including name, public key, expiration date,
and the CA’s digital signature, which certifies its authenticity.
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Components of PKI (continued)

e Certificate Authorities (CA): CAs are trusted entities responsible for issuing and
verifying digital certificates. They validate the identity of certificate applicants
before issuing certificates.

e Certificate Revocation List (CRL) and Online Certificate Status Protocol (OCSP):

CRLs and OCSPs manage and check the status of certificates, indicating whether a
certificate is valid, expired, or revoked.
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How It Works - According To ChatGPT
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How It Really Works

e Different cipher suites and key
exchange algorithms will have
different steps in establishing an
SSL/TLS session

e The process sees the client and E
server exchanging supported
protocol versions, cypher suites, etc.

e During this process a key is securely
exchanged to convert to symmetric
encryption for transmitting data for
the remainder of the session

Client

©2022 Digital Scepter. All rights reserved. digitalscepter.com

Client issues secure session request
(https.//someserver.org/somedata.html)

Server sends X.509 certificate containing server's public key

2 <
—
Client authenticates certificate against list of known certificate authorities —
Server
4 Client generates random symmetric key and R
encrypts it using server's public key
5 Client and server now both know the symmetric key

and encrypt end-user data using symmetric
key for duration of session

digitalscepter



Disclaimer
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Risks (continued)

When deploying a private CA it’s important to understand the risks involved and how to
properly secure and maintain your CA

1. Key Management Risks: Compromise of the CA’s private key or improper key storage
can undermine the entire system.

2. Certificate Management Challenges: Mismanagement of certificate issuance,
revocation, or expiration can lead to security vulnerabilities and outages.

3. Compliance and Policy Risks: Failure to adhere to standards or enforce strict
policies can result in weak security and exploitation.

4. Operational Overhead: High costs, complexity, and reliance on skilled staff make
maintaining a secure CA resource-intensive.

5. Insider Threats: Malicious or careless insiders with access to the CA can misuse it to
issue fraudulent certificates.

6. Reputation Risks: Compromise of the CA undermines trust in the organization’s
infrastructure and services.
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Risk Mitigation

It is recommended to consider risk avoidance through the below options:

1.

Use a Trusted Third-Party CA: Outsource certificate issuance and management to
established providers to offload operational and compliance burdens.

Deploy Hardware Security Modules (HSMs): Securely store private keys to prevent
compromise.

Automate Certificate Management: Use tools to track, issue, renew, and revoke
certificates automatically.

Enforce Strict Access Controls: Limit and monitor access to CA infrastructure to
prevent insider threats.

Implement Strong Policies and Audits: Regularly review and enforce certificate
policies and perform security audits.

Adopt a Hybrid Approach: Use external CAs for public-facing certificates and an
internal CA for specific internal needs.
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Offline Root CA Buildout
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Before You Start

1. Your root CA is the linchpin to your PKI’s integrity

2. Ifit’s compromised, any device that trusted your root CA is at risk, and any service
that leveraged certificate authentication should be reviewed for signs of compromise

3.  With this in mind, here are some considerations for your root CA:

It should be kept powered off

Only powered up to renew CA certs or publish new CRL

It should not be domain-joined

It should have no network connection

e. Ideally, keys would be stored on a Hardware Security Module (HSM)

4. Your root CA should only need to issue one certificate, and that is to your Issuing

(Intermediate) CA

oo
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Build Root CA

1.

2.

3.

Once the deployment platform is determined, proceed with installing a hardened

Windows installation

Create file C:\Windows\CAPolicy.inf:

[Version]

Signature="$Windows NT$"
[Certsrv_Server]
RenewalKeyLength = 4096
RenewalValidityPeriod = Years
RenewalValidityPeriodUnits = 10
AlternateSignatureAlgorithm = 0
CRLPeriod = Years
CRLPeriodUnits = 10
CRLDeltaPeriod = Days
CRLDeltaPeriodUnits = 0

In Server Manager, install the Active Directory Certificate Services Role on the
server, selecting only the Certification Authority role service during installation

©2022 Digital Scepter. All rights reserved. digitalscepter.com
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Build Root CA (continued)

1. Once installation completes, proceed with configuring the Certification Authority role
using the settings below:

Setting Value

Specify credentials to configure role services A user that is a local administrator

Specify the setup type of the CA Standalone CA

Specify the type of the CA Root CA

Specify the type of the private key Create a new private key

Specify the cryptographic Options RSA#Microsoft Software Key Storage Provider, 4096, SHA256
Specify the name of the CA Populate common name of your choice, leave other fields
Specify the Validity Period <=10 years (think golf, lower is better...and more difficult)
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Build Root CA (continued)

s ADCS Configuration - o X

. DESTINATION SERVER

Role Services labuwpkiOl
Credentais Select Role Services to configure

| Certification Authonty
Certification Authonty Web Enroliment
Online Responder
Network Device Enroliment Service
Certificate Envoliment Web Service
_| Certificate Enroliment Policy Web Service

More about AD CS Server Roles

N
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Build Root CA (continued)

& AD CS Configuration - (8] X
DESTINATION SERVER
Setup Type Labwpki0l
Credentials Specify the setup type of the CA
Role Services
_ Enterprise certification authorities (CAs) can use Active Directory Domain Services (AD DS) to
TS simplify the management of certificates. Standalone CAs do not use AD DS to issue or manage
CA Type certficates.
Privats Key
~ Enterprise CA
Cryptography Enterprse CAs must be domain members and are typically online to issue certificates or
CA Name certificate policies
Validity Pericd ® s A
Certificate Database Standalone CAs can be members or 8 workgroup or domain. Standalone CAs do not require AD

Confirmanon DS and can be used without & network connection (offlne).

More about Setup Type

(oo ] [N ] convoue | [ ot |
digitalscepter
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Build Root CA (continued)

[ AD CS Configuration - o X
DESTINATION SERVER
CA Type labwplki01
Credentais Specify the type of the CA
Role Services

When you install Active Directory Certificate Services (AD CS), you are creating or extending a

Setup Type
_ public key infrastructure (PKI) hierarchy. A root CA is at the top of the PXI hierarchy and issues its
own self-signed certificate. A subordinate CA recewves a certificate from the CA above it in the PXI
Privats Key hierarchy.
Cr)-ptcgrach-/ ® Root CA
CA Name Root CAs are the first and may be the only CAs configured in a PKI hietarchy.
Validity Period O ? cA
Certificate Catabase Subordinate CAs require an established PKI hierarchy and are authorized to issue certificates by
Confirmanon the CA above them in the hserarchy
More about CA Type

[<Previous | [ Newt> |  configure | [ Concel |
digitalscepter
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Build Root CA (continued)

B AD CS Configuration - o X
, DESTINATION SERVER

Private Key labwpkiOl
Credentials Specify the type of the private key
Role Services
Setup Type To generate and issue certificates 1o clients, a certification authority (CA) must have a private key.
CA Typs @ Create a new private key

— Use this option if you do not have a private key or want to create a new private key.

Cryptography

() Use existing private key

CA Name Use this option to ensure continuity with previously issued certificates when reinstalling a CA.
Validity Period Select a certificate and use its associated private key
Certificate Database Select this option if you have an existing certificate on this computer or if you want to
import a certificate and use its assocated private key
Confirmaton

Select an existing private key on thes computer
Select this option f you have retained private keys from a previous installation or want to
use a private key from an alternate source

More about Private Key

|¢m|| mhl (nnﬁgure” Cancel |
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Build Root CA (continued)

B AD CS Configuration

Cryptography for CA

Credentals
Role Services
Setup Type
CA Typs
Privats Key
CA Name
Validity Period
Certificate Database

Confirmation

Specify the cryptographic options

Select a cryptographic provider:
RSA#Microsoft Software Key Storage Provider ¥

B
§

Select the hash algonithm for signing certificates issued by this CA:

SHA256 ~ |
SHAJS4

SHAS12

SHA1

MDS L,

[] Aliow administrator interaction when the private key is accessed by the CA.

More about Cryptography

| <Previous | | Netn |

Configure [—]w
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Build Root CA (continued)

f. AD CS Configuration

CA Name

Cradentals
Role Ssrvices
Sstup Type
CATyps
Private Key

Cryptography

Validity Period
Certificate Database

Confirmation

Specify the name of the CA

Type a common name to identify this certification authority (CA). This name is added to all
certificates issued by the CA Distinguished name suffix values are automatically generated but can

be modified.

Common name for this CA:
| Digital Scepter Lab Root CA| ]

Distinguished name suffic

Preview of distinguished name:

CN=Digital Scepter Lab Root CA

More about CA Name

| < Previous I Next] Configure | @
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Build Root CA (continued)

s AD CS Configuration

Validity Period

Credernas
Role Services
Setup Type
CA Typs
Privats Kay
Cryptography
CA Name
| vaiaiy Percd |
Certificate Database

Confirmation

- 0 X

DESTINATION SERVER
labwpki0l

Specify the validity period

Select the validity period for the certificate generated for this certification authority (CA)
10 | Years v
CA expration Date: 11/17/2034 12:26:00 AM

The validity penod configured for this CA certificate should exceed the validity period for the
certificates it will issue.

More about Validity Period

©2022 Digital Scepter. All rights reserved. digitalscepter.com
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Build Root CA (continued)

1. Open Local Security Policy and navigate to Local Policies > Audit Policy
2. Open Audit object access and check Success and Failure

©2022 Digital Scepter. All rights reserved. digitalscepter.com

%L.‘. Security Poficy
File Action View Help Audit object access Properties ?

e AEXDTE] e o o

i Secunity Settings

> @ Account Policies j Audit otject access
v _§ Local Policies -
> & Audit Policy
> L@ User Rights Assignmen
> L@ Security Options Audt these attempts:
» | ] Windows Defender Firewal
] Network List Manager Poli 8 Success
> [ Public Key Policies @ Faure

» L] Software Restriction Polici
» | Application Control Policie
> .s IP Security Policies on Loc: This setting might not be enforced f other policy is configured to

> A ovemde catagory polcy
> (5] Advanced Audit Policy Cot s o g~ S U O

Security Setting
No auditing
No auditing
No auditing
No auditing
No auditing
No auditing
No auditing
No auditing
No auditing

digitalscepter



Build Root CA (continued)

1. Open an Administrative Command Prompt and enter the following commands,
modifying the distinguished name for your domain Configuration partition

certutil.exe -setreg CA\DSConfigDN "CN=Configuration,DC=your,DC=domain,DC=com"
certutil.exe -setreg CA\ValidityPeriodUnits 5
certutil.exe -setreg CA\ValidityPeriod "Years"
certutil.exe -setreg CA\CRLPeriodUnits 52
certutil.exe -setreg CA\CRLPeriod "Weeks"
certutil.exe -setreg CA\CRLOverlapPeriodUnits 12
certutil.exe -setreg CA\CRLOverlapPeriod "Hours"
certutil.exe -setreg CA\CRLDeltaPeriodUnits 0
certutil.exe -setreg CA\AuditFilter 127

net stop certsvc

net start certsvc
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Build Root CA (continued)

Open Certification Authority right click your CA and select Properties
Click Extensions

Select the file://... location and click Remove

Click Add and enter path found in chart below

Check box Include in CRLs... and Include in the CDP extension...

Click Select Extension dropdown and select Authority Information Access
Select the file://... location and click Remove

Click Add and enter path found in chart below

Check box Include in the AIA extension...

Make sure to update italicized values with your own

O 0N OO R W

=
e

Setting Value

CDP Extension Location http://pkiyour.domain.com/CertData/<CaName><CRLNameSuffix><DeltaCRLAllowed>.crl

AIA Extension Location http://pkiyour.domain.com/CertData/<ServerDNSName>_<CaName><CertificateName>.crt
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Build Root CA (continued)

< . Apps  Documents  Settings
Best match

' @, Certification Authority

B ostem
Settings b

Manage user certificates >
@ Credential Manager >
¥ Manage computer certificates >

#, Manage file encryption certificates >

Folders  Photos »

% 080 G

i

Certification Authority

Open

Run as admiénistrator
Run as different user
Open file location
Pin to Start

Pin to taskbar

System

& certsrv - [Certification Authority (Local)\Digital Scepter Lab Root CA]
File Action View Help
o9 nEcs H »e
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L) Centification Authonity (Local) “ Name
> [gi_Digh Ermmeme Tk Bans FA 0o Ciithcabis

All Tasks >
Issued Certdicates
View > | Pending Requests
Failed Requests
Refresh
Export List...
Help
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Build Root CA (continued)

Digital Scepter Lab Root CA Properties ? X Digital Scepter Lab Root CA Properties ? X
Envolinert Agerts Auditing Recovery Agerts Security Envoliment Agents Auditing Recovery Agents Secuty
General Policy Module Ext Module General Polcy Module Ext Module
Edenaions Sorage Catficate Managears Exansions Sorage Catficate Manasgers

Select exdersion Select extension
CRL Distrbution Point (CDP) v CRL Distrbution Point (CDP) v
a@mmnumwmamnmu mwmm‘-umm-mmn
L)
C:\WINDOW S \system 32\Cert Srv\Cest Envoll\ CCaName ><CRL Name Suffix C:\WINDOWS \system 32\Cent Sry \Cet Envoll\ <CaName > <CRL Name Suffix
ap //CN=<CATuncatedName ><CRLName Suffius CNa<ServerShod Nan Idap ///ICN=<CATn, dName ><CRLName Suffcs CNa<Server Shot N
tp J/<SN-ne>d:aNnoa-&Axdea 1p J/<ScwDNSNule>d:am

ads [Fs_] Add. Femeove
(] Publsh CRLs to this location

Publsh CRLs to this location

include in all CRLs  Specifies where to publish n the Active Directory nclude in oll CRLs  Speciies where to publish i the Active Directory
when publishing manualy when publshing manually

8 nclude in CRLs. Clents use this to find Deka CRL locations. {8 nclude in CALs. Clents use this to find Deka CRL locatione

@ nchude in the COP exdension of issued cedificates 8 nchude in the COP exension of issued cedificates

() Publeh Deha CRLs to this location Publsh Detta CRLa to this location
nclude in the IDP extension of issued CALs [} include in the IDP extensicn of issued CRLs

oK Cancel Aoply Hebp oK l Cancel l | ﬂ I Hebp
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Build Root CA (continued)

Digital Scepter Lab Root CA Properties ? X Digital Scepter Lab Root CA Properties ? X
Envolimert Agents Auditing Recovery Agents Securty Envoliment Agents Auditing Recovery Agents Security
General Polcy Modue Ext Module General Polcy Modue Ext Module
Edensions Sorage Certficate Managers Exdensions Sorage Certficate Mansgers

Select eddersion: Select extension
Authority information Accses (AlA) v Authorty nfoemation Access (AlA)

Specfy locationa from which users can obtain the certficate for ths CA Specfy locatons from which users can obtain the certficate for the CA.

CAWINDOWS \aystem 32\Cent Srv'\Cent Envoil\ < ServerDNSName >_<CaNar CAWINDOWS \aystem32'\Cert Srv'\Cet Envoll\ <ServerDNS
Kap ///CN=<CATuncatedName > CN=AIA CN=Public Key Seraces CN=!
tp//<ServerDNSName >/ Cent Ervoll/ <ServerDNSName > _CaName >

)

Name>_<CaNar
Map ///CN=<CATncatedName > CN=AIA CN=Public Key Services CN=S

tp J/<ScwDNSNun><S¢v¢0NS> CaName

CaMNams

B nolude in the AlA extension of issued cetficates 8 nchude inthe AlA extenson of issued cedficates

Include in the online cenficate status protocol OCSF) axtension () include in the onine cenficate status protocol (OCSP) extension

oK Foply Hel

oK [ﬁ]kﬂ/ e

digitalscepter
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Build Root CA (continued)

1. Open Certification Authority and expand your CA, right-click Revoked Certificates
and click All Tasks > Publish. Select New CRL and click OK

ﬁamdﬁmﬁaﬁmmmky&od)\ﬁgﬂkmrhbmawaniﬁmsl Publich CRL X
File Action View Help
o 2 E 8> The latest published Cenificate Revocation Ust (CRL) & stil vald. Chents may not

- receive a new CRL untll sfter ther cument one expires.
L3l Certification Authority (Local) RequestiD  Revocation Date  Effective Revocation Dat

v @i Digital Scepter Lab Root CA

[ Revoked Cortificates’ Type of CRL to publsh:
1 lssued Ce  AllTasks > Pubisb © New CRL
| Pending | kesues a complete CRL. which contans up to-date revocation nformation
] Failed Res View > forthe CA
Refresh
Export List Deka CRL only
itrevaded ve nof the CHL, whnch conlae )t uodate
Properties w CRL that have bex ade sros tho st time it wae published
Heip

EEORD) (oo
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Build Root CA (continued)

1. We should now have two files in
C:\Windows\System32\CertSrv\CertEnroll
a. One certificate (the root CA certificate which
contains the public key only)
b. One CRL that we published in the prior step
2. These need to be copied to the CertData folder on
the Issuing CA
3. But wait, you don’t have a network connection
4. Whether virtualized or physical, USB device is
generally your best bet
5. For virtual, an existing hard disk is an option
6. Can do virtual floppy too depending on hypervisor
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Build Root CA (finished?)

You're DONE!

Ok, with the root only

So you’re half done!

Well, a little less than half actually, there’s this thing—-nevermind, we’ll get to it

P wbhrE
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Issuing CA Buildout
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Before You Start

1. Your issuing CA will be domain-joined

2. This will simplify cert deployment, renewal, etc.

3. Permissions on cert templates are paramount

a. If these are too lax, certificates can be provisioned and misused, exposing the
organization to significant risk

4. CDP, AIA and OCSP provide end users certificate revocation information as well as
your CA certificates when they weren’t provided as part of the server chain. This is
primarily pulled via http/https.

5. If users outside of your network will need to access services using internal
certificates, then you will likely need to make these services available from outside
your network

6. In this case a separate server on a DMZ network would be ideal for hosting these files

If it is purely internal, it is not uncommon to keep this local to the issuing CA

8. For purpose of this buildout, we will consolidate these functions to the issuing CA

=
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Prepare Issuing CA

1.
selected

i Add Roles and Festures Wizard

Select server roles

Before You Begin
Installation Type
Server Selection
[ severhoes |
Featurss
Web Server Role (IS
Role Servicas

Confirmation

Roles

In Server Manager, install the Web Server (IIS) role on the server, leaving all defaults

- a X

DESTINATION SERVER
labwpkiD2 lab digitalscepter com

Select one or more roles to install on the selected server,

Description

Web Server (IIS) provides a reliable,
manageable, and scalable Web
application infrastructure.

|| Active Directory Certificate Services

[] Active Directory Domain Services

[[] Active Directory Federation Services

[] Active Directory Lightweight Directory Services
[] Active Directory Rights Management Services
[] Device Health Attestation

[C] DHCP Server

[C] DNS Server

[] Fax Server

[m] File and Storage Services (2 of 12 installed)

[[] Host Guardian Service

] Hyper-v

[C] Network Policy and Access Services

[C] Print and Document Services

[] Remote Access

[] Remote Desktop Services
[C] Volume Activation Services

[C] Windows Server Update Services

[ePovous] [ Mo ] | oot | [ concel ]

Install

©2022 Digital Scepter. All rights reserved. digitalscepter.com
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Prepare Issuing CA (continued)

1. Open IIS Manager and expand your server > Sites, and right-click Default Web Site
then click Add Virtual Directory
a. Alias: CertData
b. Physical Path: C:\CertData
2. Click CertData virtual directory and double-click Directory Browsing. Click Enable
in the Actions column
3. Enable Double Escaping on Default Web Site (required to host delta CRL’s)

C:\Windows\System32> cd %windir%\system32\inetsrv
C:\Windows\System32\inetsrv> Appcmd set config “Default Web Site” /section:system.webServer/Security/requestFiltering -allowDoubleEscaping: True

C:\Windows\System32\inetsrv> iisreset
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Build Issuing CA

1. Create file C:\Windows\CAPolicy.inf, replacing italicized values below:

[Version]

Signature = "$Windows NT$"
[PolicyStatementExtension]

Policies = AlllssuancePolicy,InternalPolicy
[AlllssuancePolicy]

OID = 2.5.29.32.0

[InternalPolicy]

OID =1.2.3.4.1455.67.89.5

URL = http://pki.lab.digitalscepter.com/cps.html
[Certsrv_Server]

RenewalKeyLength = 4096
RenewalValidityPeriod = Years
RenewalValidityPeriodUnits = 5
AlternateSignatureAlgorithm = 0
LoadDefaultTemplates = 1

Notice = "Digital Scepter Lab Certification Authority and any issued certificates are for internal usage only."

2. Install Active Directory Certificate Services Role on the server, selecting the
Certification Authority and Certificate Authority Web Enrollment role services

during installation

©2022 Digital Scepter. All rights reserved. digitalscepter.com
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Build |ssuing CA (continued)

1. Once installation completes, proceed with configuring the Certification Authority
and Certification Authority Web Enrollment roles using the settings below:

Setting Value

Specify credentials to configure role services A user that is both a local administrator and member of Enterprise Admins
Specify the setup type of the CA Enterprise CA

Specify the type of the CA Subordinate CA

Specify the type of the private key Create a new private key

Specify the cryptographic Options RSA#Microsoft Software Key Storage Provider, 4096, SHA256

Specify the name of the CA Populate common name of your choice, leave other fields

Request a certificate from parent CA Save a certificate request to file on the target machine
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Build |SSUiﬂg CA (continued)

s AD CS Configuration - O X
DESTINATION SERVER
Role Services labwpki02 lab digitalscepter.com

Select Role Services to configure

| Certification Authonty

¥ Certification Authonty Web Enroliment
Online Responder
Network Device Enroliment Service
Certificate Envoliment Web Service
Certificate Enroliment Policy Web Service

More about AD CS Server Roles

< Previous F.nb { Configure ‘ [E
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Build |SSUiﬂg CA (continued)

. AD CS Configuration - (m} p 4
DESTINATION SERVER
Setup Type labwpki02 lab.digitalscepter.com
Credentials Specify the setup type of the CA
Role Services
_ Enterprise certification authorities (CAs) can use Active Directory Domain Services (AD DS) to
= simplify the management of certificates. Standalone CAs do not use AD DS to issue or manage
CAType certificates.
Privats Key =
" ® Enterprise CA
Crypiography Enterprse CAs must be domain members and are typically online o issue certificates or
CA Name certificate policies.
validity Period ) Stand A
Certificate Database Standalone CAs can be members or 8 workgroup or domain. Standalone CAs do not require AD
Confirmanan DS and can be used without & network connection (offline),
More about Setup Type
| <ml[ Qﬂ) ] Configure H Cancel
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Build |SSUiﬂg CA (continued)

B AD CS Configuration - () X
DESTINATION SERVER
Specify the type of the CA

When you install Active Directory Certificate Services (AD CS), you are creating or extending a

_ public key infrastructure (PKJ) hierarchy. A root CA is at the top of the PKI hierarchy and issues its
own self-signed certificate. A subordinate CA receives a certificate from the CA above it in the PXI
hierarchy.

Root CA
Root CAs are the first and may be the only CAs configured in a PKI hierarchy,

& Subordinate CA
Subordmate CAs require an established PKI huerarchy and are authorzed to issue certificates by
the CA above them in the heerarchy

More about CA Type

| < Previous w > | Configure ‘ | Cancel
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Build |SSUiﬂg CA (continued)

. AD CS Configuration - (m} X
- DESTINATION SERVER
Private Key labwpki02 lab. digitalscepter.com
Credentials Specify the type of the private key
Role Services
Setup Type To generate and issue centificates to chents, a centification authority (CA) must have a private key.
CA Typs ® Creste a new private key
— Use this option if you do not have a private key or want to create a new private key.
Cryl raphy
""mg wry O Use existing private key
CA Name Use this option to ensure continuity with previously issued certificates when reinstalling a CA
Certificate Request Select a certificate and use its associated private key
Certificate Database Select this option if you have an existing certificate on this computer or if you want to
import a certificate and use its associated private key,
Confirmagion
Select an existing private key on thes computer
Select thes option if you have retained private keys from a previous instalisbon or want to
use a private key from an alternate source.
More about Private Key
[<m][ Nest> | Con&gureJI Cancel I

digitalscepter
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Build |SSUiﬂg CA (continued)

Role Services

Setup Type

CAType

Private Key

| Coptogapty |
CA Name
Certficats Request

Certificate Database

Confirmason

f AD CS Configuration = x

DESTINATION SERVER

Cryptography for CA labwpki02 lab digitalscepter.com
Credentials Specify the cryptographic options

Select a cryptographic provider: Key length:

Select the hash aigonthm for signing certificates issued by this CA:
SHA256 4

SHA384

SHA512

SHAY

MDS =

("] Allow administrator interaction when the private key is accessed by the CA,

More about Cryptography

(s ] Coutie |

©2022 Digital Scepter. All rights reserved. digitalscepter.com
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Build |SSUiﬂg CA (continued)

s ADCS Configuration - m) X
DESTINATION SERVER
Credentials Specify the name of the CA
Role Services
Setup Type Type a common name to identify this certification authonity (CA). This name is added to all
= certificates issued by the CA Distinguished name suffix values are automatically generated but can
CA Type be modified.
Privats Key
S Common name for this CA:
o i’ 2 Digital Scepter Lab lssuing CA ]
Certficate Request Distinguished name suffic
Certificate Database DC=lab,DC=digitalscepter,DC=com ]
S ascicl Preview of distinguished name:

CN=Digital Scepter Lab lssuing CA DC=lab, DC=digrtalscepter,0C=cq

More about CA Name

[ < Previous | | Next> Conbgure |
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Build |SSUiﬂg CA (continued)

B AD CS Configuration

Certificate Request

DESTINATION SERVER

labwpki02 lab. digitalscepter.com

Request a certificate from parent CA

You require a certificate from a parent certification authonity (CA) to allow this subordinate CA to
ssue certificates, You can request a certificate from an online CA or you can store your request to

3 file to submit to the parent CA,

Send a certificate request to a parent CA:

Select
* CA name
Computer name

Parent CA

Select.

® Save 3 certificate request to file on the target machine:
ab.dgitalscepter.com_lab-LABWPKIOZ-CAreq

Fie name: labwpla02

o You must manually get a certificate back from the parent CA to make this CA operational.

Morte about Certificate Request

|
| < Previous Neﬂ]! l

| Configure |

©2022 Digital Scepter. All rights reserved. digitalscepter.com
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Build |ssuing CA (continued)

1. Navigate to C:\CertData and
double-click the CA certificate file that
was copied here earlier. Click Install
Certificate

©2022 Digital Scepter. All rights reserved. digitalscepter.com

on Certificate X

General Detsis Certification Path

m Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authoritics store.

Issued to:  Digital Scepter Lab Root CA

Issued by: Dgtal Scepter Lab Root CA

Vahd from 11/17/2024 to 11/17/2034

digitalscepter



Build |ssuing CA (continued)

&+ Centificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certficates, certficate trust Ists, and certificate revocation
Ists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establsh secure network

1. Click Local Machine and then Next connactions. A cartficate store & the systam ares whare cartficates are kept.

Store Location
) Current User
© Local Machine

To continue, dick Next,

Cancel
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Build |ssuing CA (continued)

1. Click Place all certificates in the
following store then Browse and select
Trusted Root Certification
Authorities

©2022 Digital Scepter. All rights reserved. digitalscepter.com

€ & Centificate Import Wizard

Cartificate Store
Certficate stores are system areas where certificates are kept.

Vindows can automatically select a certificate store, or you can speafy a location for
the cerbficate.

() Automatically select the certificate store based on the type of certificate
© Place sl cortificates i the folowing stors

Cerbficats store:
Trusted Root Cerbficaton Authontes Browse...

@ Cancel
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Build Issuing CA (continued)

1. Copy the certificate request created earlier to the root CA...

2. TI'm sorry, it’s this again, get your virtual 5 %“ floppy ready to move some files back and
forth

3. Once you have it on the root, you can open the Certification Authority console and
right-click your CA name, then click All Tasks > Submit New Request...

4. Browse to your cert request and click OK.

5. Select Pending Requests then right-click the single request in the window and click
All Tasks > Issue

6. Select Issued Certificates and double-click the only issued certificate. Go to Details
tab and click Copy to File...

7. Select P7B format and choose a location to save this. I'd recommend your virtual
floppy drive, because guess what. This is going back to your Issuing CA

©2022 Digital Scepter. All rights reserved. digitalscepter.com d Igl talscepter



Build |ssuing CA (continued)

1. With your signed certificate back on the issuing CA, we want to open Certification
Authority and right-click your CA name, then click All Tasks > Install CA Certificate
2. Select the certificate you copied over from the root CA and click Open. The cert will

be installed and you should now be able to right-click your CA name, click All Tasks >
Start Service
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Build |ssuing CA (continued)

1. Open Local Security Policy and navigate to Local Policies > Audit Policy
2. Open Audit object access and check Success and Failure

©2022 Digital Scepter. All rights reserved. digitalscepter.com

%L.‘. Security Poficy
File Action View Help Audit object access Properties ?

e AEXDTE] e o o

i Secunity Settings

> @ Account Policies j Audit otject access
v _§ Local Policies -
> & Audit Policy
> L@ User Rights Assignmen
> L@ Security Options Audt these attempts:
» | ] Windows Defender Firewal
] Network List Manager Poli 8 Success
> [ Public Key Policies @ Faure

» L] Software Restriction Polici
» | Application Control Policie
> .s IP Security Policies on Loc: This setting might not be enforced f other policy is configured to

> A ovemde catagory polcy
> (5] Advanced Audit Policy Cot s o g~ S U O

Security Setting
No auditing
No auditing
No auditing
No auditing
No auditing
No auditing
No auditing
No auditing
No auditing
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Build Issuing CA (continued)

1. Open an Administrative Command Prompt and enter the following commands.
These will allow your CA to issue certificates with expiration dates up to 3 years out.

certutil.exe -setreg CA\ValidityPeriodUnits 3
certutil.exe -setreg CA\ValidityPeriod "Years"
certutil.exe -setreg CA\AuditFilter 127

net stop certsvc

net start certsvc
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Build |ssuing CA (continued)

Open Certification Authority right click your CA and select Properties
Click Extensions

Click Add and enter path found in chart below

Check box Include in CRLs... and Include in the CDP extension...

Click Select Extension dropdown and select Authority Information Access
Click Add and enter path found in chart below

Check box Include in the AIA extension...

Make sure to update italicized values with your own

PN A WD

Setting Value

CDP Extension Location http://pki.yourdomain.com/CertEnroll/<CaName><CRLNameSuffix><DeltaCRLAllowed>.crl

AJA Extension Location http://pki.yourdomain.com/CertEnroll/<ServerDNSName>_<CaName><CertificateName>.crt
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Build |ssuing CA (continued)

1. Open IIS Manager and expand your server > Sites, Default Web Site and click
CertEnroll

2. Double-click Directory Browsing and click Enable in the Actions column

3. We did this earlier with the CertData virtual directory, so this likely feels familiar

digitalscepter
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Build |ssuing CA (continued)

1. Open Certification Authority and expand your CA, right-click Revoked Certificates
and click All Tasks > Publish. Select New CRL and click OK

iﬂ certsrv - [Certification Authority (Local)\Digital Scepter Lab Issuing CA\Revoked Certificates]
File Action View Help

s | 7| Q= H The latest published Certificate Revocation List (CRL)is still valid. Clients may not
receive a new CRL until after their cument one expires.

Publish CRL X

il Certification Authority (Local) Request|D  Revocation Date  Effective Revocation

v gl Digital Scepter Lab Issuing CA Type of CRL to publish:
| Revoke=d Cartifiratac] : :
7 lIssuec All Tasks > Publish
71 Pendi S 2 forthe CA.
[ Failec ;
7 Certif Refresh () Delta CRL only
Export List... Issues an abbreviated version of the CRL, which contains only the updates to
the CRL that have been made since the last time it was published.
Properties

SN
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Build Issuing CA (continued)

1. We need to create a certificate for pki.lab.digitalscepter.com so we can enable https on
our Certificate Authority Web Enrollment website

2. Run certlm.msc to open your Local Machine certificate store.

3. Right-click Personal and click All Tasks > Advanced Operations > Create Custom
Request

4. Under Template select Web Server then click Details and Properties when under the
Active Directory Enrollment Policy page

5. Populate your Common Name and Alternative Name and click OK
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Build |ssuing CA (continued)

1. Populate your Common Name and

Alternative Name and click OK

©2022 Digital Scepter. All rights reserved. digitalscepter.com

Certificate Properties

/D, Subject General Extensions Private Key

The subject of a certificate is the user or computer to which the certificate is issued. You
can enter information about the types of subject name and alternative name values that
can be used in a certificate.

Subject of certificate

The user or computer that is receiving the certificate

Subject name:

Type: CN=pki.lab.digitalscepter.com
‘Common name v Add >
Value:
= < Remove |
Alternative name:
Type: | |
i pki.lab.digitalscepter.com
DNS v
Value: Add >
< Remove

digitalscepter



Build |ssuing CA (continued)

=) Certificate Enroliment

Where do you want to save the offline request?

If you want to save a copy of your certificate request or want to process the request later, save the request

to your hard disk or removable media. Enter the location and name of your certificate request, and then
click Finish.

1. Choose a filename and save in

File Name:
Base 64 fOl’mat C:\pki.reql Browse...

File format:
© Base 64

(O Binary

©2022 Digital Scepter. All rights reserved. digitalscepter.com
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Build Issuing CA (continued)

1. Open an Administrative Command Prompt and enter the following command:

certreq -attrib "CertificateTemplate:WebServer" -submit C:\pki.req

2.  When prompted save the resulting certificate. It can go in the same location as the
CSR, but specify the extension of .cer - so in this case, it would be pki.cer

3. Run the below command to import the certificate, automatically pairing it with the
private key created with the CSR:

certreq -accept pki.cer
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Build |ssuing CA (continued)

Add Site Binding ? X
Type: IP address: Port:
https ~ |All Unassigned v| 443
1. Open IIS Manager and right-click s
Default Web Site and click Edit . —
. . () Require Server Name Indication
Bindings
2. Click Add () Disable TLS 1.3 over TCP () Disable QUIC
3 Type. https [[] Disable Legacy TLS [C] Disable HTTP/2
. o . . . ("] Disable OCSP Stapling [J Negotiate Client Certificate
4. SSL Certificate: pki.lab.digitalscepter.com
5. Click OK, then Close, A
pki.lab.digitalscepter.com M Select... View...
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Build |ssuing CA (continued)

1. Still within the CertSrv virtual
directory, double-click Authentication
and Disable all options except
Windows Authentication which
should be enabled.

©2022 Digital Scepter. All rights reserved. digitalscepter.com

?a Internet Information Services (IIS) Manager

& (9 » LABWPKIO2 » Sites » Default WebSite » CertSrv »

File View Help

Q-iizI8

&5 Start Page
v €3 LABWPKI02 (LAB\zsum)
Q Application Pools
v (@ Sites
v € Default Web Site
> .| CertData
> <a| CertEnroll
> P CertSrv

g Authentication
[Z]

Group by: No Grouping X

Name

Anonymous Authentication
ASP.NET Impersonation
Digest Authentication
Windows Authentication

Status
Disabled
Disabled
Disabled
Enabled

Response Type

HTTP 401 Challenge
HTTP 401 Challenge

digitalscepter



Build Issuing CA (donel)

1. It hasto be lunch time by now
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SSL Inspection With Palo Alto
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SSL Decryption Punch List

1. The Palo Alto Networks firewalls need to be issued a subordinate CA certificate from
your newly created Issuing CA
2. Microsoft has a Subordinate Certification Authority template we can use
a. Generally, I recommend cloning the default MS templates so you can tweak them

as needed for your organization, e.g. changing the validity period.
3. Punch list should look like this:

a. Generate a CSR on the PAN firewalls

Use the web enrollment site to have cert issued via request file

Import signed certificate to PAN firewalls

Apply Forward Trust Certificate role to decrypt certificate

Generate a self-signed CA on the PAN firewalls and assign it the Forward
Untrust Certificate role

Create Decryption policies

® 200

=h
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Configure SSL Decryption

Device Groups Template

digital DASHBOARD ~ ACC ~ MONITOR  POLICIES  OBJECTS ~ NETWORK  DEVICE

:Pdrumnu v | lemplate [ labfwo1 v | View by Dev

Device Certificates Default Trus

3 High Availat
Log Forwarding Card O TTET— % X

® Password Profiles

Administrators

D NAME SUBJECT ISSUER CA | K...| EXPIRES S

Admin Re

uthentication Profile 0] E CN = github.int.dig suer=DC = DC Mar 29 05

Authentication Sequence
Usar Identification [0 Bwildcardint... CN= “intdigitalscepte... R10 Jan102:11.. v.. R..
¢ ok, loT Security ] E . CN=M - CN = Mic

£ DHCP Server Log Inges

(=]

TR [ Bepdigitalscepter.com godigitalscepter....  E6 Dec 20 18:... v.. E.. |
, [ Certificate Management
@ Certificates
B Certificate Profile

&5 OCSP Responde

=) SSL/TLS Service Profde
%f -
» = Import Generate (&) PDF/CSV I

-paloalto

digitalscepter

nformation S
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Configure SSL Decryption

Generate Certificate

Certificate Type @) Local SCEP
Certificate Name | decrypt_lab
Shared

Common Name | decrypt.lab.digitalscepter.com

Signed By | External Authority (CSR)
[[] Certificate Authority
[[] Block Private Key Export

OCSP Respor

~ Cryptographic Settings

Algorithm | RSA g

Number of Bits | 2048 v

Digest | sha256

Expiration (days)

Certificate Attributes

O | Tvre

VALUE

®HAdd O Delete

@ Cancel

©2022 Digital Scepter. All rights reserved. digitalscepter.com

digital

| Panorama v ‘

3 Setup

High Availability

Log Forwarding Card
Password Profiles
Administrators

Admin Roles

& Do 4 P @

£ Authentication Profile
,(:ﬂ Authentication Sequence

F[2] User Identification

W ov'b loT Security

"’ DHCP Server Log Inges
52 Data Redistribution
VM Information Sources
v ’E] Certificate Management
E Certificates
53 Certificate Profile
E‘z OCSP Responder

() SSL/TLS Service Profile _

3

1 »

MONITOR

[ | NaME

O | Peithud

[J P widcardintdigi..
[ ] E,f.]:}l‘\ 3ZUure

J @gp.digiulawulu...

) B

© Delete

Default Trusted Certifica

SUBJECT

CN = github.int.digitalsce

CN = “intdigitalscepter.c...

CN = gp.digitalscepter.com

“Lﬂ import

§3 Generate

[N' ; Export Certificat

v

Authorities
ISSUER CA EXPIRE
issuer=DC = com, DC = digit Mar 29
R10 Jan10:
CN = Microsoft Azure Feder Jul 7 23
Eé Dec 20
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Configure SSL Decryption

& Certificate Templates Console
File Action View Help

I certsrv - [Certification Authority (Local)\Digital Scepter Lab Issuing CA\Certificate T @ = |7 = H '
File ,,Adi,or,', Yl,e‘,N : Her 3] Certificate Templates (labwdc01 Template Display Name Actions
, Q I Z] ' Ql = | 5] Domain Controller Cgfhf% c
1% Domain Controller Authentication More
I3 Certification Authority (Local) Name In {3 EFS Recovery Agent
v @i Digital Scepter Lab Issuing CA i) Directory Email Replication D 1] Enrollment Agent
] Revoked Certificates E - o @ Enrollment Agent (Computer)
] Issued Certificates # Domain Controller Authentication C {3 Exchange Enrollment Agent (Offlin
B Peiiding Requests ] Kerberos Authentication C 13 Exchange Signature Only
~ Eailed Rg qst  EFS Recovery Agent Fi 13 Exchange User
J' ailed Requests s T psec
S Certig = ! Rasic FFS Er
Manage i Controller C @] IPSec (Offline reql..lest.)
{3 Kerberos Authentication
New > et 3 & Key Recovery Agent
uter C & ocsp Response Signing
View > Er 3] RAS and IAS Server
dinate Certification Authority <, 13l Root Certification Authority
Refresh listrator M % gouter (O:I[ine request)
- martcard Logon
Bpotet- 1 Smartcard User
& q
Help & Trust List Sic Duplicate Template
& User Al Tasks >
4] User Signatt
& Web Server Properties
PWees o . .-
— Help

Jsing this template as a base, creates a template that supports Windows Server 2003 Enterpris

©2022 Digital Scepter. All rights reserved. digitalscepter.com d Igl ta I Sce pte r




Configure SSL Decryption

Properties of New Template X ﬁ certsrv - [Certification Authority (Local)\Digital Scepter Lab Issuing CA\Certificate Templates]
Superseded Templates Extensions Security File Action View Help
Compatibility General Issuance Requirements e T T e
XICINCEY
Template display name:
PANSubCA I3 Certification Authority (Local) Name Intended Purpose
vd D!gléal Sieztecr La,!f)_ sasting Chy & Directory Email Replication Directory Service Email Replication
Template name: 9 | evodec r:fr,h |:ates E Domain Controller Authentication Client Authentication, Server Authentic...
PANSubCA ?_J ssue_ i EI Kerberos Authentication Client Authentication, Server Authentic...
| Pending Requests ;
B8 Failed Requests &l EFs Recovery Agent File Recovery
Validiy period: Renewal period: | Certificate Tem~'---- &) Basic EFS Encrypting File System
Al[yoars 5 elucas Manage roller Client Authentication, Server Authentic...
Camimn Acdle cal --J.:on
A A - New > Certificate Template to Issue on, Server Authentic...
8 "_1 g~ D"eéow i ., - - Encrypting File System, Secure Email, Cl.,
Do not automatically reenroll if a duplicate certificate exists in Active View > SEESR lty Al
Directory .ertification or <All>
Refresh Microsoft Trust List Signing, Encrypting..
Export List...
Help

OK Zooly Help

©2022 Digital Scepter. All rights reserved. digitalscepter.com
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Configure SSL Decryption

8 ' Enable Certificate Templates X & Microsoft Active Directory Cert: X +

Select one Certificate Template to enable on this Certification Authority. . c PN S Iab.dinitalcentora
Note: If a certificate template that was recently created does not appear on this list, you may need to wait until EELTE ey T g pLCE.CON
information about this template has been replicated to all domain controllers.

Al of the certificate templates in the organization may not be available to your CA.

For more information, see Certificate Template Concepts.

ory Certificate Services — Digital Scepter Lab Issuing CA

Name Intended Pupose Wolcoms

& Key Recovery Agent Key Recovery Agent Use this Web site to request a certificate for your Web browser, e-mail client, or other prog
] OCSP Response Signing OCSP Signing Web, sign and encrypt messages, and, depending upon the type of certificate you request
T RAS and IAS Server Client Authentication, Server Authentication You can also use this Web site to download a certificate authority (CA) certificate, certifica
5] Router (Offine request) Clent Authentication For more information about Active Directory Certificate Services, see Active Directory Cert
% Smartcard Logon Client Authentication, Smart Card Logon

& Smartcard User Secure Email, Client Authentication, Smart Card Logon Sele =

) Trust List Signing Microsoft Trust List Signing m

& User Signature Only Secure Email, Client Authentication View 1he Status of a pending_certificate request

] Workstation Authentication Client Authentication Download a CA certificate,_certificate chain, or CRL
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Configure SSL Decryption

Microsoft Active Directory Certificate Services — Digital Scepter Lab Issuing CA

Request a Certificate

Select the certificate type:
User Certificate

Or, submit ariadvanced certificate request_l

©2022 Digital Scepter. All rights reserved. digitalscepter.com

Microsoft Active Directory Certificate Services — Digital Scepter Lab Issuing CA

Submit a Certificate Request or Renewal Request

To submit a saved request to the CA, paste a base-64-encoded CMC ¢
server) in the Saved Request box.

Saved Request:

VAN
AL ggKtelAP2+gKIr/iP2sproEAYKcmapOYnvRIQFoPt «
Base-64-encoded | 2, 1 57 161xbi069r/MAVHZYbIOBCKIOHZVhe
sRI=

certificate request

(CMC or RO Wit T S
PKCS #10 or END CERTIFICATE REQUEST .
PKCS #7): ) .
Certificate Template:

| PANSubCA v

Additional Attributes:

Attributes:

Vz
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Configure SSL Decryption

MONITOR

i Panorama v [emplate \ labfw01 v View

Device Certificates Default Trusted Certificate Autt
&3 High Availability

Microsoft Active Directory Certificate Services — Digital Scepter Lab Issuing CA Fog borasnding Card Q

=& Password Profiles

Certificate Issued & Administrators
i ; &H@ Admin Roles [ | NaME SUBJECT ISSUER
The certificate you requested was issued to you. 88, Authentication Profile = ! o P ————
~ o N S A e 2 T SRR R
0O ® r=13) Authentication Sequence = =
DER enCOdeq or Base 64 encoded E[8) User Identification ] Bwildcardint...  CN = “intdigitalscept... R10
s Download certificate ; o[
=1 Bowmoad CeTtitatethain o tol:Secutity [0 | Pcrtsami_azur.. | CN = Microsoft Azure... | CN = Microsg

£ DHCP Server Log Inges

E] sp.digitalsce... CN = gp.digitalscepter... Eé6
é Data Redistribution B 7@“” EURN St .

VM Information Sources @

v ib Certificate Management
E Certificates

E Certificate Profile v
» © Delete =% Import | §3 Generate
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Configure SSL Decryption

Import Certificate

Certificate Type
Certificate Name
File Format

Certificate File

Key File
Passphrase

Confirm Passphrase

© Local

decrypt_lab

Base64 Encoded Certificate (PEM)

C:\fakepath\certnew.cer

SCEP Cloud

Browse.

[ Private key resides on Hardware Security Module

D Import Private Key

Shared

“ CHI:LL.I

©2022 Digital Scepter. All rights reserved. digitalscepter.com

digital

Panorama v |

Setup
High Availability

Log Forwarding Card

Password Profiles
£, Administrators
& Admin Roles

(58, Authenti

gﬂ“ Authentication Sequence

cation Profile

User Identification

ok, loT Security

1 DHCP Server Log Inges
Data Redistribution

VM Information Sources

DEVICE

femplate | labfw01

v View by De

Single V¢

Device Certificates
Q

O | NaME

O | Petnus

| @wihiLavd.1nL.digiL—uI>u.-ulv_'r,r_um
0O Po

| @gp digitalscepter.com

ml_azure_gp.shared

Default Trusted Certificate Authorities

SUBJECT

CN = github.int.digit

CN = “inLdigitalscepter.com

e Federated

z

CN = gp.digitalscepter.com

CN = decrypt.lab.digitalscepter.com

ISSUER

issuer=DC = com, DC

R10

CN = Micr e Federate

Eé

Digital Scepter Lab Issuing CA

Ir=
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Configure SSL Decryption

digital HBOARD ~ ACC  MONITOR NETWORK  DEVICE
Certificate information @ ‘ —
| Panorama v Template | labfw01 v View by Device | v | Mode
lame B3 setup A ¢ 3
Name | decrypt_lab e Setup Device Certificates tie
Subject (O ditems | S X
ucr
D NAME SUBJECT ISSUER CA | K...| EXPIRES S.. |A..| V.
Not Valid Before
wiF=" uer=DC = com, DC = d
Not Valid After Authentication Sequenc
o O Pwidcardint... CN=“intdigitalscepte... R10 Jan102:11.. v.. R.
Algorithm
v of, IoT Security O g |azu... | CN= Mi - ec 23
£ DHCP Server Log Inges 0 = = o =
v digitalscepter.col p.digitalscepter.... ec e |5
Data Redistribution S e - |

VM Information Sources
v E) Certificate Management

Eg Certificates

E] Certifl

B2 OCSP Respo

' \

e Profile

® POF/CSV

paloalto
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Configure SSL Decryption

Generate Certificate @
. . .
T g o S Certificate information @)
Certificate Name ] decrypt_lab_untrust
Shared Name | decrypt_lab_untrust l
Common Name | UNTRUSTED - DO NOT CONTINUE - DS LAB |
IP or FQDN to appear on the certificate -
Soram| 2 Subject [ /CN=UNTRUSTED - DO NOT CONTINUE - DS LAE
Certificate Authority
[ Block Private Key Export lssuer A ) °C 2
OCSP Responder | v
~ Cryptographic Settings Not Valid Before | Nov 17 23:55:19 2024
Algorithm ‘ RSA v & = = .
NumbcrofBits‘ZMS v Not Valid After | v St e N HOUSTT
Digest | sha256 Y Algorithm
Expiration (days) | 3650 \
Certificate Attributes )
O [rvee ]mug | [[] Forward Trust Certificate

orward Untrust Certificate
[[] Trusted Root CA

R | oK Cancel
Generate Cancel
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Configure SSL Decryption

Device Group Llab ]
Q 2items | =
Source Destination
NAME LOCATION | TAGS ZONE ADDRESS USER DEVICE ZONE ADDRESS DEVICE URL CATEGORY SERVICE ACTION

1  Protect Confidential lab none any % INTERNAL_NE... ' any any any any custom_no_decrypt | any
financial-services
government
health-and-medicine

2  Decrypt - Outbound ... lab none any @ labwpki02 any any any any any any
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Configure SSL Decryption
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Premiun
Solution:
Your Bus

We provide worl
with a focus on |

+

A

Certificate Viewer: digitalscepter.com

General = Details

Issued To

Common Name (CN)
Organization (0)

digitalscepter.com
<Not Part Of Certificate>

Organizational Unit (OU) ~ <Not Part Of Certificate>

Issued By

Common Name (CN)
Organization (O)
Organizational Unit (OU)  <Not Part Of Certificate>

decrypt.lab.digitalscepter.com
<Not Part Of Certificate>

Validity Period
Issued On

Expires On

SHA-256
Fingerprints

Certificate

Public Key

Saturday, November 2, 2024 at 4:32:50PM
Friday, January 31, 2025 at 3:32:49PM

e4690b9097c9cc9eb199ea933692c651e193f807bfac62ffb74a5deBcas
beba
3d8530e404e56b3819bcd7a7d74bd28e7389655¢c8ee7ebe2dbleeccdd
79469c3
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Configure SSL Decryption

@ labwpkio2 X

:. (im] untrusted-root.badssl.com x =
&< O © Notsecure | hitps//untrusted-root.badssl.com A 7y
i . A X
Certificate Viewer: *.badssl.com
General = Details
Issued To
Common Name (CN) *badssl.com
Organization (O) BadSSL
Organizational Unit (OU) <Not Part Of Certificate>
Issued By
Common Name (CN) UNTRUSTED - DO NOT CONTINUE - DS LAB
Organization (O) <Not Part Of Certificate>
Organizational Unit (OU) <Not Part Of Certificate>
Validity Period
Issued On Thursday, November 7, 2024 at 11:29:42 AM
Expires On Saturday, November 7,
SHA-256
Fingerprints
Certificate 1e5970b35fb4cdedcdf140909e9b2dc64ef42fb044a7 16aa76738013
48183
Public Key 3¢37835aa49c533 1cfelce495d92b7ad570d00f11dc2788afdcae26f0d99
dfc4
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Conclusion

e Thanks for attending!

e Implementing Zero Trust Security Principles
Today at 4 pm in Harbor G (2nd floor)

e Falco product demonstration Wednesday at 10 am
Tomorrow at 10 am in Expo Hall Lobby Room B
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What is Falco?

e Atoolto detect
configuration issues

e A managed service to assist
with fixing them

e Product demonstration
Wednesday at 11 am
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@ FALCO

Summary

80% passed
1 Devices Audited

Failed Check Severity

4.0

3.0

20

1.0

0.0

Policies

Critical

Objects

High

Device

A

Medium

1/1 devices
Recommended Releases

Low

Informational

Sample Falco Report

Falco Plus

Device = PA5250-1 v

ey Support Licenses
ﬁ MO YlnerpbiBES s @ All Devices Have Valid Support

No Known Vulnerabilties Found )
Licenses

Report History

42

,0-0:0
35._._'...._‘ﬂ.'.'.'.'.'.'.'.&._..‘_._._‘ﬁ.'.

28
21

14

.'.'.'.'.'.................ﬂ".'."'.'.h.

7

*0-9.0-0

R R T
ee‘? S E RS S P SO A A A R AT AR R A



888) 299-3718




